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INTRODUCTION 

GENERAL 
Word 97 is a word processing package produced by Microsoft. It is easy to use, nice 
to look at and full of clever features that will enable you to create a variety of 
professional looking documents with ease. 

Word 97 integrates fully with other Windows programs, such as Excel, PowerPoint 
and Mail.  This allows you to incorporate text, data and graphics from other programs 
into any Word document, and vice versa. 

This manual assumes a basic knowledge of Windows 95. 

DEFINITION OF INSTRUCTIONS 
All instructions in this document are in “bold and quotation marks”.  Where you need 
to use the Keyboard, the keyboard commands will appear in square brackets eg press 
[Return]. 
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USING THE RULER 

The Ruler is used to format the document, it defines the presentation of the text. 

The ruler appears at the top of the screen, the settings it contains refer only to the 
area of the document where the cursor is currently located. 

In order to affect an area of text simply locate the cursor within the text or highlight the 
area by dragging the cursor down. The changes made will affect the indicated area. 

 Tab Select

 First Line Indent

 Left Margin
 Rest of

Paragraph
Indent

 Left Aligned Tab

 Centre Tab

Right Aligned Tab

Decimal Tab

Right Margin

Right Side Indent

 

SETTING THE RIGHT (AND LEFT) MARGIN 
The margins are shown in the ruler as darker grey shaded areas, the pale area with 
the numbers is the width of the document measured in inches. 

The margins, both left and right, can be dragged to the desired width of the document, 
however, to do this you need to be in Page Layout view, see the section above for full 
details. 
Once in “Page Layout” view 

 Move the arrow to the point where the light and dark area meet. 

  
 Your cursor will turn into a double headed black arrow. 

 Click whilst the cursor is a double headed black arrow and drag the 
margin to its new location. 

In most cases, for standard documents, it is only necessary to adjust the right margin. 
To adjust the left margin, perform the same action to the left side of the Ruler. 

 Click whilst the cursor is a double headed black arrow and drag the 
margin to its new location. 

It is best to return to “Normal View” at this point to continue creating your document. 
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INDENTING PARAGRAPHS 
In all cases discussed below there are two methods of application, you can either: 

 Set the indent setting and then type the text 

 Select previously typed text, and then use the settings to indent it. 

 Click on the square block under the “Rest of Paragraph” indent and drag 
the indent to the desired location. The text in the paragraph will adopt the 
setting in the ruler. 

 

NB The Paragraph indent icon splits into two parts - see diagram above. It is important 
that both parts are moved together as the top section refers to the top line of the 
paragraph and the bottom refers to all subsequent lines. Should they separate, pull 
one to the other by clicking on and dragging the triangular sections. 

Automatic Paragraph Indents 
 There are automatic indents set every ½ inch along the ruler. For a fast 

indent, you can use the Increase or Decrease Indent icons - mainly the 
Increase Indent icon. 

Decrease
Indent Icon

Increase
Indent Icon

 

 Click on the icon to indent text by ½ an inch, this will automatically move 
the “Paragraph indent” icon in the ruler. Repeat this to indent 1 inch etc. 
Use the other icon to decrease the paragraph indent. 

USING THE RIGHT INDENT 
The “Right indent” is used to control where text stops on the right side of the page. It is 
a triangular block - see diagram - usually set at the same location as the Right margin. 
This block can be moved to the left to restrict text, perhaps to create a column, eg: 

 Click on the triangular block on the right hand side and drag the indent 
to the desired location. The text in the paragraph will adopt the setting in 
the ruler. 

 

It is worth noting that the “Right Indent” can also be pulled to the right ,ie beyond the 
Right margin, this allows the text to exceed the Right margin if required. 
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TAB SETTINGS 
There are 4 types of Tab settings. They are only useful for single lines of text or 
entries of data, eg creating columns, lists or tables containing a series of entries. The 
tabs can be used at any location on the ruler as frequently as required. 

 Press the [Tab] button to move the cursor to each “Tab” setting or series 
of settings. Text can be inserted on your arrival at the setting or you can 
“Tab” past the setting to leave it blank. 

 

 Tab settings are NOT valid for formatting text paragraphs.  

 
 Left Justified - Will line up text on the left side 

 Right Justified -  Will line up text on the right side 

 Decimal -  Will line up the decimal point in numbers 

 Centre -  Will centre text below this point 
 

 

To Select a Tab Type and Set it In The Ruler 
On the left side of the ruler is a block - see diagram, It displays the “Tab” types. If the 
required “Tab” is displayed in the “Tab Type Selector” block: 

 Click on the Ruler at the location you want the “Tab”. The setting will 
insert itself in the ruler. 
 

If the “Tab” displayed is incorrect:  
 

 Click on the “Tab Type Selector” block. Each time you click, a new Tab 
Type appears. Click till the desired “Tab” is displayed 

 Click on the Ruler at the location where you want the “Tab”. The setting 
will insert itself in the ruler. 

 

To Move A Tab 
 Click on the “Tab” and drag it  - and any text it affects - to the new 

location 

To Remove a Tab from the Ruler 
 Click on the “Tab” and drag it down toward the document ie “off the 

ruler”. The Tab will disappear. 
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To Change A Tab 
 First remove the original “Tab”, and then reinsert the new required tab 

type. 
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BULLETS AND LINE NUMBERING 

Simple line numbering and bullets can be added to text as you type. In both cases you 
can either: 

 initiate the character then type the text 

 or 

 type the text then add the character 

 

BULLETS 
 Click on the “Bullet” icon, a bullet point will appear left of the text. 

  
 To remove bullets, click again on the icon 

 

NUMBERING 
 Click on the “Numbers” icon 

 

A number will appear left of the text. Eg: 

1. Food 
2. Drink 
3. Rent 

 To remove Numbers, click again on the icon 
 

GENERAL 
To insert spare lines within the numbers or bullets without adding the character: 

 Press [Shift] with the [Return] key. 

To select the Group standard presentation for numbering and bullets 

 Use the “Style” option to select either “List Bullet” or “List Numbering” 

These options will create a standard indent of 0.5”. 
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HEADERS AND FOOTERS 

Headers and Footers are designated areas of text which print respectively at the top 
and bottom of every page in the document. 

TO CREATE OR AMEND HEADERS AND FOOTERS 
 Click on “View”, then click on “Header and Footer”. 

To display the Header and Footer, Word will have to go into Page Layout View 
(assuming it is not in that display already). For clarity of view in setting or changing 
the Header or Footer you should use “Zoom” and select “Page Width” view or larger. 

 

 

 

In either case, the area(s) will acquire a border of dotted lines, the normal horizontal 
ruler, an additional “Vertical Ruler” - to the left of the area - and lastly the Header and 
Footer toolbar. 

 

 

 

 

 

The Header and Footer areas are just a smaller area of word processing, they can be 
formatted just as you would normal text in the document. You can use the icons in the 
toolbar to add date, time, page numbers etc. 

 

Increasing and Decreasing The Size of The Area 
Click and drag on the margin settings in the Horizontal and Vertical Rulers above and 
to the left side of the area.  

 

Vertical 
Ruler 

Insert  
Autotext 

Select Header or 
Footer 

Last or Next Header 
or Footer 

Insert Page 
Number 

Insert Number of 
Pages 

Front Page 
Number 

Date Time 

Page 
Setup 

Header/Footer 
Same as 
Previous 

Show/Hide 
Document Text 
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TABLES AND COLUMNS 

Most of the column set ups used in the Group are in tabular form, ie a series of pieces 
of information on a subject running across the width of a page. Therefore, in most 
cases tables will be sufficient to produce the presentations we require. 

TABLES 
A table can be created in two ways, either: 

  Click on the “Tables” icon, a sample table will appear. 

 

Initially, this table will be 4 rows by 5 columns wide, you can click and drag over the 
grid to select a smaller area or drag and pull the grid from left to right to expand it to 
the size you require to a maximum of 18 rows by 13 columns, eg 3 rows by 2 
columns, 2 rows by 8 columns. 

Or for larger tables you can use the Table menu. 

 Click on “Table” then click on “Insert Table”, a dialogue box will appear: 

 

 Select the number of rows - unlimited - and the number of columns - a 
maximum of 31 by clicking on the small arrows. 

 Set the column width to a reasonable size - if you leave it on auto it will 
fit them automatically to the page margins. Now click on “OK”. 

 

NB it is prudent to put a least one carriage return above the grid otherwise 
the position of the table will not allow work above that point.  
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Also in this box is the “Autoformat” button. Autoformat will help you create more 
complicated tables and format them in advance with Years, Quarters etc. It is 

worth investigating this option to see if it can be used in your area of work. The 
Wizard will make suggestions and allow you to select options in the design of 

your table. 

 

Once you have selected your rows and columns, a grid of lines - cells - will appear on 
the screen and the ruler at the top will show the column margins. Your cursor will be in 
the top left corner cell. You can now start entering your text. 

 

MOVING AROUND THE TABLE 
 Use the [Tab] key to move from one cell to the next along the grid or use 

the cursor keys to go in any direction you wish 

 

SELECTING TEXT IN TABLES 
 

To select a Cell Click on the left of the cell 
To select a Row Click to the left of the row 

To select a Column Click on the column, then click on “Table” in 
the menu bar and “Select Column”. 
Alternatively move the cursor over the top of 
the column, till it turns into a black arrow 
and click. 

To select the Whole 
Table 

Click on “Table” in the menu bar and “Select 
Table”. 

To select any area Click and drag over the area you want 
 

 

ADJUSTING THE WIDTHS OF THE COLUMNS 
As you create the Table a Ruler will appear. It will show the left and right margin 
markers and the individual column markers. 

 

 Click on the marker for the column to be adjusted and drag to a new 
location 

 You can also click on and drag the column grid markers to the required 
width in the table itself. 
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Alternatively you can set width of column and row height in the Table menu. This is 
particularly useful if you wish to set standard widths for columns 

 Select the table - or columns - where standard widths apply. 

 Click on “Table” then click on “Table Properties” 

The following will appear 

 
 Click on the tab “Column” 

 Set the desired width required at “Preferred Width”  

If the table goes of the end of the page 

Use Table  Autofit  Autofit to Window to automatically resize the table to fit it 
on the page. 

Make the Columns or Rows the same size with The Tables and Borders 
toolbar 

 Click on the Tables and Borders icon  to view the toolbar 

 

 
 

 Click on the Distribute Rows or columns Evenly  
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INSERTING OR ADDING ANOTHER ROW 
 Position the cursor on the row BELOW where you want the new row to 

appear 

 Click on the insert row icon, a new row will appear.   

To add another row to the bottom of the table 

 Position the cursor on the bottom right cell 

 Press the [Tab] key 

 

INSERTING OR ADDING ANOTHER COLUMN 
 Position the cursor on the column to the RIGHT of where you want the 

new column to appear. 

 Press [Alt] and click to select the whole column. 

 Click on the insert column icon, a new column will appear  

 

TO DELETE ROWS OR COLUMNS 
 Select the Row(s) or Column(s) to be deleted 

 Click on “Table” then click on “Delete Rows” or “Delete Columns” 

 

ADDING UP TOTALS 
There is the facility to add up the totals of the entries in a column. 

 Click on the area (Cell) to contain the total 

 Click on “Table” then click on “Formula”,  a dialogue box will appear: 

 

 

Select the presentation by using the 
down arrow next to “Number Format” 
then click on “OK”, the total will appear 
in the cell. 

 

Alternatively click on the autisum button  on the Tables and Borders Toolbar 
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CREATING HEADINGS AND TITLES 
Headings and titles can be created at any point in the table. 

 Select the cells across which the heading is to go. 

 Click on “Table” then click on “Merge Cells”. 

 

To Reset Heading Cells As Table Cells  
To reset heading cells as table cells or to split cells into a number of sub columns. 

 Select the cells 

 Click on “Table” then click on “Split Cell”, a dialogue box will appear 

 

 Select the number of columns you want 

 

USING THE TABLES AND BORDERS ICON 
Another way to create tables is to use the Tables and Borders toolbar.  
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When the Draw Table icon is indented you can click and drag to insert a table box like 
below. 

 

 

You can then click and drag the pencil cursor around the screen to attach more rows 
to your table or split the table into more columns. See the example below. 

 

 

  

  

 

You can then use the toolbar icons to perform the commands you desire, ie 

 Erase a line 

 Split cells 

 Merge cells 

 Alignment options 

 Etc. 
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LINES, BORDERS AND SHADING 

You can add lines, borders and shading to text by using the “Borders” icon. 

 Select the text you wish to add the presentation to. 

  Click on the “Tables and Borders” icon. The “Borders” toolbar will 
appear. 

 

 Click on the down arrows to select a “Style of Line” and “Type of 
Shading” 

 Use the drop down arrow beside the Borders icon to select the table lines 
you require 

 

To make the lines, borders or shading fit text shorter than the full 
width of the page, use the Right and Left indents in the ruler.  

 

TO CLEAR BORDERS OR LINES 
 Select the paragraph you wish to remove the presentation from. 

 Click on the drop down arrow beside the Borders icon to select the table 
lines you require to delete 

 

TO CLOSE THE BORDERS TOOLBAR 
 Click on the “Tables and Borders” icon again. The Toolbar will disappear. 
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THE STANDARD DOCUMENTS 

In order to make the use of the standard documents easy and consistent, they have 
been set up as an option on the Word menu. There are a variety of documents 
available, dependent on your department. You will be notified locally which to use. 

The list of standard forms may vary, however, the following will always be available: 

 Trustletter The Trust and NHHO. 
 Groupletter Care Services, Shops and CP. 
 Fixed Date Letter The Trust and NHHO. 
 Memo All 
 Agenda All 
 Minutes All 
 Fax All 
 Comcov All 
 

SETTING YOUR USER NAME 
The standard documents - excluding the Letter formats - are set up to include a footer 
line displaying the Username and the File Location details. In order to ensure your 
name appears at the bottom of the documents you must set the details in Word. 

 Click on “Tools” in the menu bar, then click on “Options”. 

 A dialogue box will appear, from the headings presented, click on “User 
Info” 

 Delete any old information and then insert your own details 

 

Repeat this each time you move location to ensure your details are correct. 
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ACCESSING THE FORMS 
Access to the standard forms has been included on the menu bar under “Forms”. 

 Click on “Forms” in the menu bar, a drop down menu will appear showing 
the forms available: 

 
 Click on the name of the type of form you want to produce eg Memo 

The blank form will appear on screen, along with a dialogue box. Eg: 

 

 
The dialogue box will ask you to insert  information to complete the document. 

 Key in the information for each request, then click on “OK” or press [Tab] 
then [Return] to confirm the entry. 

The text you have typed will be inserted at the appropriate place in the document. 

 If you have no information to key into the field, just click on “OK” or press 
[Tab] [Return]  and you will go to the next entry. 

When the dialogue box disappears you are in a normal document and in free text, just 
type the rest of the document. Dates etc are incorporated automatically. 

 

All documents - except the letters - have a footer line. In order for the document 
name and file location to appear on the bottom of the document, you MUST 

SAVE the document BEFORE YOU PRINT, otherwise all that will be printed is 
“Document3”. 

 
Full details of how these documents should be completed are included on example 
sheets at the rear of this manual, should you be unsure of any entry, please consult 
the relevant example and follow the instructions for the required entry. 
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PARAGRAPH FORMATTING 

Paragraph formatting will primarily be used to set the Indents and Spacing in the 
document. 

The main purpose of using spacing in the document is to prevent unnecessary 
multiple return keystrokes appearing in the document. 

In order to set the spacing  

 Select “Format” then “Paragraph” 

The Paragraph dialog box will appear 

 

 
 

From Here you can set the indentation for the paragraph. 

You can also set the spacing before and after the paragraph or the line spacing within 
the paragraph. 

Look at the preview box to see how your settings will appear on the document. 
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STYLES 

Large documents should incorporate styles in order to make it easy for the author to 
change all instances of that style in one go. 

MODIFYING AN EXISTING STYLE 
To modify an existing style you should 

 Select the text with the style that you want to alter, the style will appear in 
the style box on the formatting toolbar 

 Apply or remove the extra formatting 

 Then select the style from the drop down style box menu 

The modifying style dialog box will appear. 

 
 Select the option Update the style to reflect recent changes? 

 Click on OK 

This will then change all text that has that style applied to it in one go. 

Note the change to the style in the drop down style box menu as well. 

 

CREATING A NEW STYLE 
This will allow you to create your own style and add it to the drop down style box 
menu. 

 Select a paragraph and apply all the formatting you wish 

 Highlight the writing in the style box 

 
 Type in the name of your new style 

 
 Press [return] 
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This will add your new style to the drop down style box menu 

 

 
 

RENAMING A STYLE 
This will allow you to rename an existing style. 

 Select the style you want to rename 

 Highlight the style name in the style drop down menu box 

 Overtype the style with the new style name 
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PAGE BREAKS  

AUTOMATIC PAGINATION 
The text you type into your document appears in a continuous 'text stream' that 
spreads down the page.  When the text reaches the bottom of the page Word 
automatically creates a new page, and the 'text stream' spreads on to it. 

If you are in Page Layout view you can see a grey gap between the bottom of one 
page and the beginning of the next. 

If you are in Normal view a dotted line appears in the text that represents the end of 
the page. 

MANUAL PAGE BREAKS 
If you wish to end a page before the bottom of the page, you will need to insert a 
manual page break.  This will stop text appearing on the page after the break, and all 
subsequent text will appear at the top of the next page. 

To Insert A Manual Page Break 
 Insert the cursor into the text where you want to end the page 

 In the “Insert" menu, select “Break” 

This will bring up the Insert Break dialog box. 

 Ensure that the "Page Break" option 
is selected 

 Click “OK 

A Page Break will be inserted into the page at 
that point. 

Alternatively, you can use the following 
keyboard shortcut: 

 Press [Ctrl]+[Return] 

 

If you are in Page Layout view, the page break will be invisible.  If you want to delete 
the break, you will need to show the 'Invisible (non printing) Characters', so that you 
can see it. 

To Delete A Page Break  

 Click on the "Show/Hide" button on the Standard Toolbar    

The page break will now be visible as a dotted line with the word "Page Break" on it. 

 Click in the left margin, to the left of the break to select the break 

 Press the [Backspace] key to delete it 

 


